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Upgrading to Visual
Studio 2005

Moving to a new development environment can sometimes be daunting. Visual Basic 6 users came
head to head with a significant learning curve when Visual Basic .NET was first released in 2002. In
fact, the transition to the new language was so overwhelming that some high-profile gurus in the
language refused to move over and started campaigns to bring back the original language constructs.

Many corporations faced with the effort required in converting to .NET also decided to hold off,
and as a result the current Visual Basic programming world is divided into two sizable camps,
Visual Basic 6 programmers and Visual Basic .NET developers, with the rare few using both tools.
The crux of the problem in transitioning to the new language was that the core Visual Basic lan-
guage evolved to more closely suit object-oriented principles and to synchronize with the NET
Framework.

Therefore, instead of a language that had its origins in an interpretive compiler, Visual Basic .NET
utilized the paradigm of everything being an object and therefore being treated as such; even
forms and their controls were transformed into “just another” object that inherited from a class in
the NET Framework. As a result of these functional changes to the language, it was difficult to
automatically upgrade Visual Basic 6 code to the new .NET environment, even with the Upgrade
Wizard.

Besides the significant language changes, there were new concepts to consider, including proper
inheritance and features such as method overloading. Coupled with these language-side issues,
the environment itself also changed. Mostly the changes were improvements over the old way of
doing things, but in the process of creating a new development environment, Microsoft left out
some major features on which Visual Basic 6 developers depended. The most prominent feature
that got left behind was the edit-and-continue process that enabled programmers to edit their code
while the program was running in debug mode and then allow the program to continue running,
taking advantage of the new altered code without having to restart the program.
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When Microsoft began work on Visual Studio 2005, they told the programming world that their intention
was to make this version of Visual Studio full of features that developers wanted, as opposed to those fea-
tures that Microsoft itself thought they needed. Two such features that were on the lips of every Visual
Basic programmer were the return of the edit-and-continue feature and a more convenient way of
upgrading Visual Basic 6 code. Edit-and-continue is dealt with in Section IX, where the debugging fea-
tures of Visual Studio 2005 are discussed, but this chapter is all about upgrading Visual Basic 6 code to
Visual Basic 2005.

The Upgrade Process

You should approach the upgrading process carefully. In fact, the first serious decision you have to make
is whether to upgrade at all. Visual Studio 2005 applications can interact with Visual Basic 6 applications
through the COM Interop layer, so if you have an existing application that just needs to talk to new pro-
grams, then your best option may actually be to leave the VB6 project as is. However, if you need to do a
major rewrite of an existing project, then it might be a great time to convert it up to Visual Basic 2005 to
take advantage of the many benefits of producing applications in .NET 2.0.

Either way, besides the most basic program, it is most likely that the upgrade process will include a list
of tasks as well as compilation errors and warnings, all of which need to be addressed before the con-
verted program will run as expected. In addition, you’ll need to check every conversion point in the
application code to ensure that it still acts as you expect.

If you're going through a total rewrite of an existing application, you may even want to start a new pro-
ject in Visual Studio 2005 and use the Upgrade Visual Basic 6 Code tool to migrate the old program code
a section at a time to make it more manageable.

Getting Ready to Upgrade

To give the upgrade process the best chance of success, there are some guidelines to follow in preparing
the Visual Basic 6 code for the conversion. These optional tasks minimize the impact of some common
issues that the Upgrade Wizard faces, such as default properties.

Things That Just Won’t Work

Some features of Visual Basic 6 are so incompatible with Visual Basic 2005’s new language model that
the Upgrade Wizard can’t handle them at all. For instance, code that uses the graphic methods on forms
(or even the Line and various Shape controls) cannot be converted at all and needs to be completely
rewritten.

Similarly, applications that take advantage of the drag-and-drop commands in Visual Basic 6 need to
have those sections recreated using the new techniques within .NET 2.0.

A large number of Windows API definitions cannot be converted over to Visual Basic 2005 because they
rely on Variant and Any. Variants will be converted to Objects, which means in some cases the behavior
of the application will change, while the Upgrade Wizard can’t replicate the behavior of any. However,
the NET Framework contains many functions that eliminate the need for calling the Windows API
directly. Therefore, while you’ll need to rewrite those sections of code that call Windows APIs, you can
take advantage of the managed code functionality found in the framework instead.
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One last issue worth mentioning is that if the Visual Basic 6 application uses DAO for its data access
(such as to a Microsoft Access database), then it will require a reworking of the data access layer because
Visual Studio 2005 doesn’t support data-binding to DAO.

Changing the Original Code

The many issues that can occur during the upgrade can be loosely grouped into two sets. The first set of
problems is items that work fine in Visual Basic 6 but don’t work at all in Visual Basic 2005; however,
changing them in the original code doesn’t necessarily make sense. For instance, the graphics methods
for a form such as Cls and PSet are not available in Visual Basic 2005. However, you can’t easily change
the code in Visual Basic 6 before you perform the upgrade to the new graphics methods, because the
NET Framework-based methods aren’t available from the Visual Basic 6 code. Control examples
include the Line and Shape controls mentioned previously; these don’t have a corresponding compo-
nent in .NET and are converted to empty Label controls at best.

In both of these situations, you're forced to accept your fate and perform development on the converted
code to regain your original application’s behavior.

However, other features of Visual Basic 6 that do not convert well in the Upgrade Wizard have alterna-
tives in Visual Basic 6 itself. If you're more comfortable with working in Visual Basic 6, a little bit of
work in the original code base can help immensely with the upgrade process.

For example, the Timer control in Visual Basic 6 has an Enabled property, but many programmers
chose to simply set the Interval property to 0, which effectively paused the Timer. However, when-
ever you set the Interval value to 0 in Visual Basic 2005, it implicitly converts the setting to 1, which
means the Timer continues to run and fire. To avoid this issue cropping up when you upgrade your
application code, make sure you use the Enabled property instead of setting Interval to 0.

This problem is a great example of code that will be converted without error but have unexpected
results. If you leave the code with the improperly coded Interval = 0 statement, your Timer may
fire a little more frequently than you ever intended it to!

Upgrading other Visual Basic 6 code features may produce warning messages that can be easily avoided
by changing the code before the upgrade process. The most common issue of this type is the capability
to use default properties in Visual Basic 6. This is the practice of simply referring to the object or control
and letting Visual Basic determine what property should be used. For example, a TextBox has a default
property of Text, so instead of assigning a string to the Text property explicitly like this

TextBoxl.Text = myString

you can simply specify the TextBox1 control and Visual Basic implicitly assumes the Text property; the
following line is the equivalent of the previous line of code in Visual Basic 6:

TextBoxl = myString

Visual Basic 2005 does not support default properties at all, requiring you to explicitly specify the prop-
erty to which you're referring. The Upgrade Wizard does a great job of trying to determine what prop-
erty it should use when converting the code, but sometimes it just doesn’t know what to do. Figure 45-1
shows an example of this kind of problem — the Upgrade Wizard couldn’t determine the default prop-
erty of the ListView control’s Item object.
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MainCompile.vb*|" Function is not supported Start Page -~ X

‘ﬁgfrmMainCompile ~| | 5 DoCompiles -

i i

Exit For -

End If ]
'UPGRADE WARNING: Lower bound of collection lvwQuickPOSProjects.ListItems has changed from 1 to 0. Click for :

If 1vwQuickPOSProjects.Items.Item(lCounter).Checked Then
If FileExist (sTempLogfile) Then Kill((sTempLogfile))
' UPGRA! G: Lower bound of collection lvwQuickPOSProjects.ListItems has changed from 1 to 0. Click

Lower bound of collection 1vw kPOSProjects.listItems () .ListSubltems has changed from |
aTemp = sippAndPath & " /m """ & 3QuickPOSRoot & "\" & 1lvwQuickPOSProjects.Items.Item(lCounter).Text & ""

Lower bound of collection lvwQuickPOSProjects.ListItems has changed from 1 to 0. Click
Lower bound of coll ion 1ve kPOSProjects. ms ()

Couldn't resolve default property of cbject lvwQuickPOSProje
lvwQuickPOSProjects.Items. Item(lCounter) .Subltems. Item(4) = FSCompilation started®

tems has changed from

cts.ListItems () .ListSubltem

1Response = ShellAndWait (sTemp, AppWinStyle.Hide)
If 1Response = 0 Then
Sleep (1000}
' read the log file to determine the problem or success |

< >

Figure 45-1

Explicitly coding the property names in the original Visual Basic 6 code in the first place avoids this
problem entirely. The MSDN Library documentation that comes with Visual Studio has many other rec-
ommendations (look for the topics entitled Preparing a Visual Basic 6.0 Application for Upgrading and
Language Recommendations for Upgrading).

Using the Upgrade Project Wizard

When you are ready to convert a Visual Basic 6 application project to Visual Basic 2005, you can do so by
simply opening the project file (with a .vbj extension) in Visual Studio 2005. The Visual Studio IDE
determines that the project is from an older version of Visual Basic and automatically starts the Visual
Basic Upgrade Wizard.

After reviewing the goals of the Upgrade Wizard, click the Next button to progress to the first step. The

first choice you have is whether the application should be converted to a Windows application (.exe) or
a binary library such as a DLL or custom control. Normally this choice is taken out of your hands, as the
wizard attempts to determine the project type by reading the original project information.

The next step is to select the destination for the Visual Basic 2005 version of the project (see Figure 45-2).
Note that the Upgrade Wizard will not convert the project in place. In fact, it won’t allow you to convert
the application into anything but an empty folder. If you specify a location that doesn’t exist, the wizard
will ask you if you want it to create the folder automatically for you.

The default location for the wizard is a subfolder underneath the original project file’s location, but you
can set it to anywhere within your local file system.

Your work is now done. Click Next to get to the confirmation page, and then click Next one more time to
start the actual Upgrade Wizard. As the wizard progresses through the conversion, the dialog updates
the status message with the current module and member being upgraded (see Figure 45-3). The status
bar of the main Visual Studio IDE also dynamically updates, showing the percentage of completion for
the upgrade process.
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Visual Basic Upgrade Wizard - Page 3 of 5

Specify a Location for Your New Project

The wizard will place your new project files in a new folder. !

Where do you want your new project created?
al visual Studio 2005101 Initial Draft\n Progress\598465 ch46\POS Subclass\POSSUbdass NET

The project will be created as: C:\Data\Work\Wiley Active\Professional Visual Studio 200501 Initial Draft\In
Pr...\POSSubdass.NETY

< Previous ] [ Next >

Figure 45-2

Visual Basic Upgrade Wizard - Page 5 of 5 [2JE3

Please wait... |
The systemis upgrading your projectto Visual Basic 2005. =

Status: Upgrading GSubdass.get_Currentmessage

Cancel

Figure 45-3
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Most of the time, the Upgrade Wizard will complete the process and present you with a list of errors,
warnings, and additional tasks for you to check (this is discussed in the next section “Checking the
Upgrade Output”). However, some programs cannot be converted at all, and will present you with an
error message. Usually, when this occurs it is because the original code itself wouldn’t compile.

Figure 45-4 shows an example of the kind of message that can be produced. This example application didn’t
convert because the referenced DLLs in the project were not registered on the machine doing the conver-
sion. As noted at the bottom of the message text, if this kind of error occurs, your first step should be to
make sure the program compiles and runs in Visual Basic 6 before trying the Upgrade Wizard again.

Visual Basic Upgrade Wizard error

@ Upgrade failed: Exception occurred: Could not load referenced components:
POSCommonDialog.dll {(QuickPOS Common Dialog Library 10.1.0),RasX DLL (Mabry Internet

RAS/K COM Object 1.0.0),REGOBJ.OLL (Regstration Manipulation Classes
1.0.0),POSKeyboardOptionsB.dll (QuickPOS Keyboard Options B 1.0.0),POSPeripherals. dll
(QuickPOS Peripherals 1.0.0),POSDBJet dll (QuickPOS Database Object
1.0.0),POSFunctions. dil (QuickPOS Functions 1.0.0),POSKeyboard dll (QuickPOS Keyboard
1.0.0),POSKeyboardOptions. dll (QuickPOS Keyboard Options 1.0.0),POSKeyboardOptionsA_dll
(QuickPOS Keyboard Options A 1.0.0),POSKeyboardOptionsC.dll (QuickPOS Keyboard Options
C 1.0.0).,POSMessageBox.dll (QuickPOS Message Box 1.0.0)
It is recommended you install VB6.0, with all referenced compenents, and ensure the application
compiles and runs before upgrading.

Figure 45-4

Unfortunately, sometimes you’ll get a blank error message. This kind of error is extremely rare, and nor-
mally points to a project that is somehow incomplete, such as missing files. When you encounter this
kind of error, you can still determine where the error occurred by viewing the log file that is produced as
the Upgrade Wizard does its work.

This log file is located in the destination project folder you specified in the wizard, and is made up of
XML nodes detailing each file as it is upgraded. Scrolling through the log you can identify the point at
which the upgrade failed, and then look at that specific file’s contents (see Figure 45-5). In this sample
case, it turned out that the attempted conversion of the source file failed because the file didn’t exist
where the project file expected it to.

POSOptions.log | Function is not supported Start Page - X

Upgraded = "True” 71

\Work\Wiley
B\Work\T

ve\Professional Visual S
ve\Professional Visual

"C:\Data\Work\b
"Cr\Daca\Work\l
"Hodule™

= "False"

ive\Professional Visual Studio 2005%\
ive\Professional Visual Scudio 2

ror"

4-6D52-4F59-B392-A7837C4DC5F2"

L </UpgradeLog>
< ¥

Figure 45-5

642



Upgrading to Visual Studio 2005

Checking the Upgrade Output

When the Upgrade Wizard is complete, it opens the new Visual Basic 2005 project in the IDE. If there are
any issues to address, they are added to the Task List and the Error List with all the associated
IntelliSense formatting that comes with warnings and errors applied to the code listings themselves. In
addition, an Upgrade Report is generated and added to the project’s file list in the Solution Explorer.
Examining each of these upgrade output elements is the best way to make sure your application was
converted successfully.

Task List

The first port of call when reviewing the upgrade output is the Task List. Visual Studio 2005 should dis-
play this automatically, but if it’s not shown, use the View=>Other Windows=>Task List menu command
to display it. The result of a typical conversion will appear similar to what is shown in Figure 45-6.

Task List - 11 tasks > 1 x

Comments I

!'| Description File Line
TODO: Review the values of the assembly attributes AssemblyInfo.vb 10
UPGRADE_WARNING: Class instancing was changed to public. Click for more: ‘ms- ISubclass.vb 3
help://MS.¥SCC.v80/dv_commaner localfredirect. htm ?keyword ="ED 410 348-3890-49FC-80 76-BDEFC 2F42A85™
UPGRADE_WWARNING: App property App.EXEName has a new behavior. Click for more: 'ms- Subdass_bas.vb 262
help: {MS.¥SCC.v80/dv_commoner flocal redirect. htm?keyword ="68A988D2-2A32-486E-8D36-449499974A 564"
UPGRADE_WWARNING: Add a delegate for AddressOf WindowProc Click for more: ‘ms- Subdass_bas.vb 354
help:{MS.VSCC. v80 fdv_commoner flocal fredirect. htm?keyword ="ESE 157F 7-EF0C-4016-8 7B 7- 7D FFBBCEEEDS™
UPGRADE_WARNING: Couldn't resolve default property of object iwpT. Click for more: ‘ms- Subdass_bas.vb 554
help:/M3.¥SCC, w80/ dv_commoner flocal fredirect. him?keyword ="6A50421D-15FE-4396-3A 1B-2EC21E30375 2"
UPGRADE_WARNING: Couldn't resolve default property of object iwpT. Click for more: ‘ms- Subdlass_bas.vb 557
help:/M3.¥SCC.v80/dv_commoner flocal fredirect. htm?keyword="6A50421D-15FE-4396-3A 1B-2EC21E30375 2"
UPGRADE_WARNING: Class instancing was changed to public. Click for more: 'ms- Subdass_cs.vb 3
help://MS.¥SCC.v80/dv_commaoner localfredirect. htm ?keyword ="ED 410 34B-3890-49FC -80 76-BDEFC 2F42A85™
UPGRADE_WWARNING: Lower bound of array aTimers was changed from 1 to 0. Click for more: 'ms- Timer_bas.vb 12
help: /M. VSCC. w80 fdv_commoner flocal fredirect. htm?keyword="0F 1C9BE 1-AFSD-476E-838 1-17D43BECFF20™
UPGRADE_WARNING: Add a delegate for AddressOf TimerProc Click for more: 'ms- Timer_bas.vb 32
help: /M3, YSCC, w80 fdv_commoner local fredirect. htm?keyword ="ESE 15 7F 7-EF0C-40 16-8 76 7- T FFBBCEEEDS™
UPGRADE_WARNING: Couldn't resolve default property of object StoreTimer. Click for more: 'ms- Timer_bas.vb 151
help:/M3.¥SCC, w80/ dv_commoner flocal fredirect. htm?keyword ="6A50421D-15FE-4396-3A 1B-2EC21E30376 2"
UPGRADE_\WARNING: App property App.EXEName has a new behavior. Click for more: 'ms- Timer_cls.vb 35
help://MS.¥SCC.v80/dv_commaner localfredirect. htm?keyword ="6BA958D 2-2432-466E-80 36-449499 744 564

Figure 45-6

Generally, the warnings and TODO tasks are added to the code where actual compilation warnings or
errors will not occur. This is because while the Upgrade Wizard was able to successfully convert the
code to what it expects is the correct Visual Basic 2005 code, you are encouraged to review its changes.

The majority of messages in this list will be of the variety that you can simply acknowledge and delete.
For instance, Figure 45-6 shows a warning about the lower bound of an array being changed from 1 to 0.
This is because arrays in Visual Basic 6 are 1-based, skipping over the Oth element, while Visual Basic
2005 follows the more common mechanism of including a Oth element in the array. While most of the
time you can simply ignore the extra element in the array, some particular code constructs may exhibit
different behavior.

The other warnings in the list may require more interaction. Again, looking at the sample list in Figure 45-6,
there are some warnings about default properties for certain objects not being resolved. This situation

causes a compilation error and needs to be addressed before the converted project can be built successfully.

Each entry in the Task List links to the associated line of code containing the problem. Double-clicking the
entry in the list takes you directly to the line in question and the full warning message (see Figure 45-7).
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Every warning message also contains a link to a documentation entry in the MSDN Library explaining
why there could be an issue with the particular statement. For example, the warning shown in Figure
45-7 indicates that the App . EXEName was converted to My .Application.Info.Assembly

Name, but that there are differences between the two objects. Clicking the link ultimately takes you to a
help topic that explains in great detail any differences between the old Visual Basic 6 App object and its
equivalent in Visual Basic 2005.

App Object for ... Basic 6.0 Users *'Subclass_bas.wb* | ISubdass.vb | Start Page - X
# modSubclass v | ¥ErrRaise v
v~ Py —J
Commentcs: ™
History:

' Date Inits Modification

Lndrew

Dim sText, sSource As String
If e > 1000 Then

'UPGRADE WARNING: App proper
'Click for more: 'ms-help: ("

C. 0/dv_commoner/local/redirect.htm?kevword="6BASEEDZ -
sSource = My.Application.Info.AssemblyName & ".WindowProc"
Select Case e

Case EErrorWindowProc.eeCantSubclass

sText = "Can't subclass window"
Case EErrorWindowProc.eelAlreadyAttached

sText = "Message already handled by another class™
Case EErrorWindowProc.eelnvalidWindow

sText = "Invalid window"
Case EErrorWindowProc.eeNoExternalWindow

sText = "Can't modify external window"™

End Select

Err.Raise(e Or vbObjectError, sSource, sText)
Else

' Raise standard Visuwal Basic error

Fww Daisais  sSnmwemal

Figure 45-7

Errors and Warnings

Once you've reviewed the Task List, you should next turn to the Error List tool window (accessible via
the View=>Error List menu command). Because Visual Basic 2005 performs background compilation of
code, any compilation errors that have been produced in the process of creating the new project are auto-
matically flagged, added to the Error List, and marked in the code through the IntelliSense engine.

Figure 45-8 shows a sample Error List after the upgrade of a Visual Basic DLL project. This project was
very small but contained a sizeable number of errors due to the purpose of the code. As mentioned pre-
viously, the As Any construct is not supported in Visual Basic and cannot be upgraded (you would need
to define individual declarations for each variable type you were going to pass to the function). In addi-
tion, the code is using the unsupported objPtr function.

Some errors will be easier to fix. While the Upgrade Wizard may not be able to determine the default

property of the Item object in a ListView, a human programmer can easily determine that the Text
property was intended to be used, and correct it in just a few moments.
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Error List > a2 x
| 1\ 5 Warnings ‘ i) 0 Messages
Description File Line Column Project i
J 1 ‘'As Any'is not supported in ‘Dedare’ statements. Subdass_bas.vb 36 88 POSSubdass
@ 2 'As Any'is not supported in ‘Dedare’ statements. Subdass_bas.vb 36 112 POSSubdass
4 3 Variable 'sText' is used before it has been assigned a walue. A null reference exception  Subdass_bas.vb 275 43 POSSubdass
could result at runtime.
4 4 Variable 'sSource' is used before it has been assigned a value. A null reference Subdlass_bas.vb 278 17 POSSubdass
exception could result at runtime.
@ 5 Mame 'ObjPtr'is not dedared. Subdlass_bas.vb 319 46 POSSubdass
& 6 Mame 'ObjPtr' is not declared. Subdlass_bas.vb 340 61 POSSubdass
@ 7 'AddressOf expression cannot be converted to 'Integer’ because 'Integer' is not a Subdlass_bas.vb 358 47 POSSubdass
delegate type.
& & MName'ObjPtr'is not dedared. Subclass_bas.vb 457 46 POSSubdass
@ 9 'AddressOf expression cannot be converted to 'Integer’ because 'Integer’ is nota Timer_bas.vb 33 66 POSSubdass
delegate type.
4 10 Function 'StoreTimer' doesn't return a value on all code paths. A null reference Timer_bas.vb 157 2 POSSubdass
exception could occur at run time when the result is used.
4y 11 Variable 'sText' is used before it has been assigned a walue. A null reference exception  Timer _ds.vb 43 43 POSSubdass
could result at runtime.
4y 12 Variable 'sSource’ is used before it has been assigned a value. A null reference Timer _ds.vb 46 17 POSSubdass
exception could result at runtime. ha

| Error List || Task List

Figure 45-8

While compilation warnings don’t stop your application from running, you should seriously consider
and investigate each warning after an upgrade process to ensure that the expected behavior will occur.
In the sample shown in Figure 45-8, errors 3 and 4 occur because String variables are accessed without
first being assigned a value (you could leave these, or correct them by setting them to vbNullString in
the declaration of each variable).

However, error 10 may be more serious depending on how the Upgrade Wizard handled the function. In
some cases the wizard would be able to convert the appropriate statements to Return values, but if the
return type is an unusual type it may not even be able to do that. Either way, you should definitely
investigate the code that has produced the warning.

Upgrade Report

If you prefer a more visually pleasing view of the upgrade output, you can view the Upgrade Report.
This report is generated after the Upgrade Wizard has completed and is placed in the project’s folder
with a name of _UpgradeReport.htm. It is then added to the Files list in the Solution Explorer.

Opening the page in a browser shows a nicely formatted report, as shown in Figure 45-9. At the top of
the report is a summary showing how many errors and warnings were found during the upgrade pro-
cess and of what type.

Underneath this summary section is a details table containing the errors per physical file contained in
the project. This details view is handy for determining which parts of the project require the most work.

Each of the tables can be collapsed and expanded to manage the detail.

Printing the report will only include the visible information; if you need to print the report in its
entirety, make sure you first expand all nodes in both tables.

645



Chapter 45

#] POSSubclass.vbp Upgrade Report

&) POSSubclass vbp Upgrade Report

File Edit View Favorites Tools Help

Upgrade Report for POSSubclass.vbp

Time of Upgrade: 10/02/2006 4

Upgrade Summary
Types of Issues Found

El Compile Errors

All parameters in a Declare statement must be fully qualified

=l Some functions are no longer supported

El Subclass.bas
# Location
1 AttachMessage
2 AttachMessage
3 DetachMessage

Object Type Object Name

= Warnings

The instancing of classes defined as SingleUse, GlobalSinglelUse, or
GlobalMultiUse were changed to Public

Arrays must all have a lower bounds of zero

Some properties and methods have a new behavior

The AddressOf function now requires a delegate function

Some late-bound default property references could not be resclved
Total

E Details For Each File in Project

New Filename Original Filename

@ C:\Data\Work'\Wiley Active\Professional Visual Studio 2005101 Initial Draft\In Progress\598465 ch46\POS Subdass\POSSubclass.NET\_Upgrade| ¥ *5

Learn More

Issues were found that will prevent your project from compiling. These
issues will need to be resolved before the application will run.

t support parameters of type As Any

Property
ObjPtr
ObjPtr
ObjPtr

Description

There were some differences found that may causes unexpected results

when your application is run. You should test your application thoroughly to

verify that it functions as desired.

Class instancing

was changed to Public

r bound of &

Late-bound default

11

mora e

File Type Status Errors Warnings Total Issues
= (Global Issues) 1] 1 1
Global update issues: -
£ Severitv | neatinn Ohiect Tvna Ohiert Name Pronerty Nascrintinn ]

_e My Computer

Figure 45-9

Unflagged Issues

Some issues can crop up in your conversion that are not flagged at all. These are usually related to situa-
tions that the Upgrade Wizard cannot determine, such as differences in literal value meanings.

A great example of this is the kinds of errors that can occur at runtime. When trapping errors using the
On Error statement, often code is hard-coded with specific error numbers. Because the behavior may be
different in Visual Basic 2005, different errors may be produced, which can cause unexpected results. The
MSDN documentation has the following sample listing that illustrates this issue:
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On Local Error GoTo Result
Dim x() As Boolean

Dim y As Variant

y = x(10)
Result:

If Err.Number =

Else

9 Then
Do something.

Do something else.
End If
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When this code is run in Visual Basic 6 it will generate an Err object with a value of 9, which means
“Subscript out of range.” However, because Visual Basic 2005 requires you to initialize any object (which
includes arrays) before using it, you will get a different error number.

Because this kind of unseen issue can occur, it is always highly recommended to do a complete code
review of upgraded projects.

The Upgrade Visual Basic 6 Tool

If you need only to convert a block of code instead of an entire project, whether it’s a single code state-
ment or a full module, you will find the Upgrade Visual Basic 6 Code tool extremely useful. New to
Visual Studio 2005, this utility is available from the Tool menu when you are editing a class or module in
Code view.

When you start the utility, it displays a small dialog window containing a blank text area in which you
can enter the Visual Basic 6 code to be converted (as shown in Figure 45-10). If the code uses COM
objects, you can add the references to each COM object you require in the References tab.

Upgrade Visual Basic 6 Code [B[%]

Code |References

Enter Visual Basic & code to be upgraded:

Dim 1FileHandle As Long 1~
Dim wfdFileData As WIN32_FIND DATA

' Check that the file exists
1FileHandle = FindFirstFile (sFilePath, wfdFileD
FileExist = 1FileHandle <> INVALID HANDLE VALUE

Call FindClose (lFileHandle)

End Function

Upgrade ] [ Close

Figure 45-10

When the code and references are ready for conversion, click the Upgrade button to start the conversion
process. This uses the same internal engine as the Upgrade Wizard, and automatically inserts the newly

converted Visual Basic 2005 code into the module at the current insertion point. Any necessary COM ref-
erences are automatically added to the project’s reference list.

Some additional errors may occur when converting a small block of Visual Basic code, such as convert-

ing a statement that includes an undefined variable. To avoid these, try to include everything that the
particular code will need prior to clicking the Upgrade button.
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Summary

Visual Studio 2005 comes with two utilities to migrate your Visual Basic 6 code over to the new language
constructs —an Upgrade Wizard to convert complete projects to Visual Basic 2005, and a code snippet
converter utility for converting individual functions or single modules of code. The two tools in conjunc-
tion enable you to upgrade Visual Basic 6 code more easily than ever, and along with the new features of
Visual Studio 2005 (such as edit-and-continue), pave the way for Visual Basic 6 programmers to transi-
tion to .NET.
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